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Freeway Exercise

Solutions for OEMs, FreeStudio
Thermostat exercise
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Chapter 1
Function Description

Goal:
Describe thermostat flow chart 
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Thermostat cycle

∆Set point Temperature

Actuator

ON



5Schneider Electric | Industry Business | OEM Technical Training | April 2014 | Aidin Aliyarzadeh

Thermostat states (function description)

Actuator

OFF

Actuator

ON

Temp ≥ Setpoint+∆

Temp < Setpoint
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Chapter 2
Programming

Goal:
- Familiarizing with programming environment
- Creating Thermostat Function Block
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Creating New project

2*click

2*click

1

2
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Creating New project
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Creating New project
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Programming environment

1
2

3

4

5

5

6

75

Выступающий
Заметки для презентации
1. The Output window is the place where Application prints its output messages. 
2. The Status bar displays the state of the application at its left border, and an animated control reporting the state of communication at its right border.
3. The Watch window is one of the debugging tools supplied by Application.
4. The Library window contains a set of different panels, which fall into the categories explained in the following paragraphs.
5. The Workspace window consists of three distinct panels, as shown in the following picture.
6. The Application programming environment includes a set of editors to manage, edit, and print source files written in any of the 5 programming languages defined by the IEC 61131-3 standard.
7. The Oscilloscope window is one of the debugging tools supplied by Application.
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Programming Languages
The FREE STUDIO platform is compatible with all 5 standard programming 

languages (IEC 61131-3).

5 programming languages, 2 text-based and 3 graphics-based:
• ST, Structured Text,language text
• FBD, Functional Block Diagram language graphical
• LD, Ladder language graphical
• IL, Instruction List language text
• SFC, Sequential Function Chart language graphical
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Thermostat program 1. Right click on the programs
2. New program
3. Select language
4. Name it
5. Assign it to the background or timer task
Note: The main (default) program can be 
deleted if not used (Rename is possible, 
Editting language is not possible).

See the next slide for Task detail 

1 2

3

4

5

*
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Associating a program to a task
For a program to run, it must be associated to a task.
There are various types of tasks:
• BOOT Task runs once only at system start-up.
• Init. Task runs each time the application is downloaded and after BOOT.
• Timed. Task runs at regular intervals which can be set by the developer. 
The default setting is 100ms.

•Background. Task runs with low priority after the Timed tasks (between the end 
of one Timed task and the start of the next), it can be interrupted in case of long 
execution or executed more than 1time in case short execution.

Note Each new project has the main program associated to the background task 
(the main program can still be eliminated and/or associated to other tasks).

To activate a task, go to the task you want, right-click and select Add program
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Tasks
• BOOT Task runs once only at system start-up.
• Init. Task runs each time the application is downloaded and after BOOT.
• Timed. Task runs at regular intervals which can be set by the developer. The default setting is 
100ms.
•Background. Task runs with low priority after the Timed tasks 
(between the end of one Timed task and the start of the next).

Period of 
task timed

Execution 
time of
task timed

Period
task timed

Execution
task timed

Period of
task background

Execution time of
task Background

Actual execution time, background task
Start Execution

Background Task

Read 
Input

Update
Output

Execution
task Boot

Execution
task Init

Update 
Display

Read 
Input

Update
Output

Read 
Input

Update
Output Read 

Input
Update
Output

Update
Output

Update 
Display

Executed only after a 
download
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Assigning program to the task

Tasks►Background ►right click ►add program



16Schneider Electric | Industry Business | OEM Technical Training | April 2014 | Aidin Aliyarzadeh

View FBD toolbar

1. View
2. Toolbars►FBD bar
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New function block creation

1. Right Click
2. New function block
3. Select the language
4. Assign a name 
5. Double click on the Hysteresis to open the editor 
related to the selected language.

Note: Try to create function if the block does not require 
static RAM, it will optimize the RAM usage

5
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Insert record

1

2

5

43

6

4

5 & 6. Optional
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Inside Hystersis FBD

Compile result is valid as soon 
as FBD used in the program

Set point
∆
Probe Alarm
Actuator
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FBD in Background
1. Double click on the Thermostat programt to 
open the editor that is related to the program
2. drag & drop
3. Name it
4. Add new network

Drag & Drop
1

2

3

2
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Set password for written FB

You can prevent access 
to your written codes 
inside of FBD by cript.
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Assigning local variable to the FBD

2

1

3

3
1. Add new record
2. Name it
3. Define the type from object browser
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Connecting Variables to the FBD

Select Input/output

Drag & Drop

Shortcuts:
Space: Connecting Mode ◄► Insert/Move Mode
Ctrl+Left Mouse Button: Multiple Selection
Ctrl+Shift+F: Find in project
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FBD toolbar…

1 2 543 6 7 8 9

1. Connection
2. Watch
3. New block
4. Variable
5. Constant
6. Return
7. Jump
8. Comment
9. Increase number of pins
10. Decrease number of pins
11. Display enable I/O pins
12. FBD properties
13. View source

1
0

1
1

1
2

1
3

1
1

11. The output will not 
update if En=False

9
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Cross Reference

1. Find in project (cross reference)1

1
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Compile/Build

Compile

Double click on the error to 
refer to the error source
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Chapter 3 
Simulation/Debugging – Part 1

Goal:
Debugging created FB by different off-line 
simulation tools such as Watch or Oscilloscope
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Off line simulation mode

Debug►Simulation mode ►

1. Debug
2. Simulation mode
3. Name it ► OK
4. If differs or no code
5. Download  the code, OK
6. Reset Variables

1 2

5
4

3 6

5

2
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On-Line Status / Application Status

The state of communication is shown in a small box next to the right border of the 
Status bar. 

If you have not yet attempted to connect to the target, the state of communication is set 
to Not connected. 

When you try to connect to the target device, the state of communication becomes one 
of the following: 

-Error: the communication cannot be established. You should check both the physical 
link and the communication settings. 

-Connected: the communication has been established 
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On-Line Status / Application Status

Next to the communication status there is another small box which gives 
information about the status of the application currently executing on the 
target device. 

When the connection status is Connected, the application status takes on one 
of the following values. 

-No code: no application is executing on the target device.

--Diff. code: the application currently executing on the target device is not the 
same as the one currently open in the IDE; moreover, no debug information 
consistent with the running application is available: thus, the values shown in 
the watch window or in the oscilloscope are not reliable and the debug mode 
cannot be activated. 
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On-Line Status / Application Status

--Diff. code, Symbols OK: the application currently executing on the target 
device is not the same as the one currently open in the IDE; however, some 
debug information consistent with the running application is available (for 
example, because that application has been previously downloaded to the 
target device from the same PC): the values shown in the watch window or in 
the oscilloscope are reliable, but the debug mode still cannot be activated. 

-Source OK: the application currently executing on the target device is the 
same as the one currently open in the IDE: the debug mode can be activated.
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Debug mode/Changing values

1. 2*click on required variable
2. Edit the value
3. Set the values
4. Check the Output status
5. Check the Alarm status 

In probe disconnection, short circuited or 
broken the value= - 32768

6. Debug mode (optional)
7. Live (continuous) debug mode (optional)

2* Click

Edit value

7

4

1

2

3

5

6
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Watch configuration

Save watch list

Drag & Drop

Watch list formats

Watch list is 
independant from 
live debug mode
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Watch/ drag & drop

1. Select watch icon
2. Select the variable
3. Select the watch
4. ► OK
5. It adds to watch list

1

2

43
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Watch Configuration/ST language

1. Select the variale
2. Double click
3. Drag & drop it directly to 

the watch properties1 2

3

*
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Oscilloscope
View ►Tool windows ► Async graphic windows ►
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Assigning variable to the oscilloscope

Drag & Drop

Up to 8 channels could be 
traced simultaneously
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Assigning variable to the oscilloscope
1. Select watch icon
2. Select the variable
3. Select the Oscilloscope
4. It adds to oscilloscope list

2

4
3

1
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Oscilloscope tools/starting & stopping data acquisition 

When you add a variable to the Oscilloscope, data acquisition begins 
immediately. 

However, you can suspend the acquisition by clicking on Pause acquisition.
The curve freezes (while the process of data acquisition is still running in 

background), until you click on Restart acquisition. 

In order to stop the acquisition you may click on Stop acquisition.

In this case, when you click on Restart acquisition, the evolution of the 
value of the variable is plotted from scratch.
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Oscilloscope tools/ Vertical split

1.Selected track‘s vertical show all
2. Horizental show all
3. Show all values
4. When you are watching the evolution of two or more variables, you may want 

to split the respective tracks.
5. The tool highlights the single values detected during data acquisition. 
You can click on the same item again, in order to go back to the default view 

mode.
6. The Oscilloscope includes two measure bars, which can be exploited to take 

some measures on the chart.

14 3 256
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Oscilloscope tools/ Setting the scale of the axes

When you open the Oscilloscope, Application applies a default scale to the axes. 
However, if you want to set a different scale, you may follow this procedure: 

1) Open the graph properties
2) Set the scale of the horizontal
axis & sampling polling rate
3) Specify a distinct scale for the
vertical axis. 
4) Confirm your settings. 

2

4

3

1
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Oscilloscope/export

1. Save icon
2. Name & format defining

-OSC: simple plain-text file, containing 
time and value of each sample

-OSCX: XML file, that includes more 
complete information

3. Open it via Excel (OSCX )

1

2 Available formats
2

3
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Chapter 4
Resources

Goal:
Defining the resources:
- Assigning physical Input/output
- EEPROM parameters
- Status variables
- Menu definition and navigation
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Physical I/O Mapping (Base Unit)...

1

2
3

4

1. Resources
2. I/O mapping
3. Local
4. Name variables

2. I/O Mapping definition:

Local: Base I/O
Extend: Expansion
Remote: Keyboard
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...Physical I/O Mapping (Base Unit)...

After saving the project, all 
the defined resources will 
be available under Global 
shared folder; 
Mappings in case of I/O

1

2

2
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...Physical I/O Mapping (Expansion)

Note.
In case of loosing 
communiucation between Base & 
expansion:
All DO‘s = 0
All DI‘s = False
All Probes = -32768

3. It can use as communication 
alarm variable
4. They can only use in watch

1
2

3

4
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How to configure I/O types, range?

1. Menu Developer ► Open with free studio device

Note: BIOS parameters are also available on the installation manual

1
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Check FS Device parameters description...

1
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...and define the Application BIOS Default

1. BIOS parameters
2. Add
3. Select the name
4. Select the type

31

2

4
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EEPROM parameters

3

1. Resources
2. EEPROM parameters
3. Add
4. Define required „retain“ data
5. 1% resolution

Format XXX.Y
Note:Default values are written to the 

target  only by Free Studio Device

1

4 5

App. Type : IEC variable type
Device Type : FS Device / Display type
App. Type = Scale x Device Type + Offset

2
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EEPROM Properties

1

1

EEPROM Parameters:

App. Type : IEC variable type
Device Type : FS Device / Display type
App. Type = Scale x Device Type + Offset

Note.
Dynamic setpoint by the other parameters
Min/Maxis possible.

4

2

3

42 3
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Status Variables

1

2
3

1. Resources ►Status variable
2. Add new record
3. Define required RAM data
4. Valid range

Note: Same properties as 
EEPROM + read only

App. Type : IEC variable type
Device Type : FS Device / Display type
App. Type = Scale x Device Type + Offset

4

3
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Alarms

1

2

3

4

1. Resources
2. I/O mapping
3. Alarm
4. Add

4.1   Name
4.2   without short name
4.3   7 segments preview
4.4   with short name
4.5   7 segments preview

- It is automatic folder which display
the Alarms, if value is 0, no display 
In AL folder if alarm value is 1, 
displays  the short name.
blinks if value> than 1.
- In case of any alarms, the red 
triangle icon in the display is on.
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Fundamental state display configuration

- Display
- Fundamental state display
- Desired variable in the display



55Schneider Electric | Industry Business | OEM Technical Training | April 2014 | Aidin Aliyarzadeh

Menu Program – Add Folder

1. Menu Prg.
2. Add Menu
3. New Menu, name it (Cfg)
4. 7 segment preview

1 2 3 4
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Menu Set – Add Folder

1. Menu Set, Right Click Add Menu
2. New Menu, name it (Setting Menu)
3. 7 segments preview

1 2 3
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Add/Remove elements to folder

1 3

2

1. Add
Open the list sorted by names

2. Select the parameter
3. Add again
4. Select the other parameter4
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Add/Remove elements by drag & drop 

Drag & Drop
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Menu Program – How to Access

To form & define the program button function:
1. Menu Prg, access by pressing Prg button in simulation
2. Menu Prg, access by pressing esc.& set buttons 

simultaniously on the product
3. Scroll up or down into the defined variables ▲▼

1

2

3
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Menu Set – How to Access

To form & define the set button function:
1. Access to the set menu by pressing set in simulation
2. Access to the set menu by pressing set on the product
3. Scroll up or down into the defined variables ▼▲

1

2

3
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Menu architecture

MSet

Main Menu

AlPassPar

I/O M

SetPrg

↑ ↓ ↑ ↓ 

Main Menu

↑ ↓ ↑ ↓ 

Cfg

Diff SetP

Temp

Main Menu

Set

F5

ValueValue

Value

0 Err1

Free

Prg

Cf

PassPar

↑ ↓ ↑ ↓ 

Set

Cf**

Set

F5

Set

Set

↑ ↓ ↑ ↓ 

SetSet

Set

Set Set
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Project / Global Shared

Drag & Drop

All the resources are available in the 
project tab under Global Shared folder 
(after saving or compiling the project)
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Using physical I/O 

Drag & Drop
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System LED setting

1

2

4

3
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System local LED assigning
1. 2*click
2. Variable property
3. Dedicate required LED
4. Type [6] ► Output ► OK
5. Type [9] ► Output ► OK
6. Type[10] ► Output ► OK
7. Dedicated LED‘s

1
2

3

4 5 6

7
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Connecting dedicated LED‘s to the FBD

1

3

2

4

5

Digital Input map

Digital output map

4
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Valorize Fundamental State Display
1

3

2
v

47

1. Insert bottom (new network)
2. Adding new network
3. Select Move block
4. Drag & drop to new network
5 & 6. Mapping ◄► Variables
7. Connect to Move block

* Move command is mandetory to connect two variables.

5
6
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Compile/Build

Compile

Double click on 
the error to refer to 
the error source
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Chapter 5
Simulation and Debugging – Part 2

Goal:
On-Line simulation mode, testing of:
- Physical I/O 
- 7 segment display 
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Off line simulation mode

Debug►Simulation mode ►

1. Debug
2. Simulation mode
3. Name it ► OK
4. If differs or no code
5. Download code, OK
6. Reset Variables
7. Debug mode (optional)
8. Live debug (Continuous) mode (optional)

1 2

5
4

3 6

87

5

Smart
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Simulation tools
1. Active code execution
2. Show I/O panels
3. Show HMI window

1 2 3
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Open Free Studio Device from Application

1. Developer ► Open with Free Studio Device

1
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Free Studio Device (Simulation Target)

Connect to the target►Connected feedback

Note: Free Studio Device does not download the code in Simulation, it 
is used only for setting EEPROM parameters and check Status
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2

Read / Write Values

1. Connect to the target►Connected feedback
2. Application►Project►Cfg
3. Cfg menu►non aligned value with target (Red)
4. Auto refresh mode (optional)
5. Select all parameters (or selective)
6. Write parameter (all or selective)+ download all
7. Aligned values  with the target (black)

1

3

4

5

6

7

6
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Menu Navigation

Start - Prg - Set

Set ▲,▼
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Menu Navigation

Start Set Set

Set ▲,▼
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Setting the setpoint

Start

Press Set to validate
Press esc  to cancel

Set ▲,▼

Defaul value aligned with
the Free Studio Device
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Setting the differentiation

Start

Press Set to validate
Press esc  to cancel

Set ▲,▼

Defaul value aligned with
the Free Studio Device
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Message

Out of range message
Only can disply:
- 99.9.....999.9 

Free Studio Device does
not write default values
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Testing program/applying values

 Setpoint=26.0, Differentiation=10.0 & Ambient_Tempereature =37.0 
⇒ DOL1= ON & ☼ = ON  

 Setpoint=26.0, Differentiation=10.0 & Ambient_Tempereature =25.0
⇒ DOL1= OFF & ☼ = OFF 

 Setpoint=26.0, Differentiation=10.0 & 26.0<Ambient_Tempereature<36.0 
⇒ DOL1= ON & ☼ = ON

 Ambient_Tempereature =-32768 
=> DOL1= OFF , ☼ = OFF & DOL2= ON (probe disconnection alarm= ON) 
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Smart Project Architecture

●Application is the programming starting point.

●Device is used to download the overall compiled project and it is the only tool able 
to write EEPROM parameters.

●From Application it will always be possible to open Device directly without having 
to launch the program using the FREE Studio icon.

Download
Code & 
EEPROM
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Chapter 6
Hardware

Goal:
Introduction of products that are used in training stand and target pin-out
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1. M171O/SMART
2. M171P/EVOLUTION
3. EVE*
4. EVK1000
5. Digital input

I0-I7 ► M171P
I8-I15  ► EVE*

6. Digital Output
Q0-Q3 ► M171O
Q4-Q9 ► M171P
Q10-Q15 ► EVE*

7. 24VDC power supply
8. NTC probes (AI1*) 
9. Analogue Output

AO1 ► M171O
AO2 ► M171P

10. Analogue Input
AI1 ► M171O
AI2 ► M171P
AI3 ► ATV21

11. Digital input
I0 & I1(level) ► M171O
I2 & I3 (edge)► M171O

12. Variable Speed Drive
ATV21 (1 to 3 phases)

13. Short circuit 
ptotection (GV3P)

14. LV distribution &  
protection

15. Asynchronous 
motor

9
8765

4

32

1
0

1

1
4

1
3

1
2 1

5

1
1
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Training Stand I/O wiring diagram
M171O Description Label

DI1 Switch DI 1 (level) DI0-O

DI2 Switch DI 2 (Level) DI1-O

DI3 Switch DI 3 (Pulse) DI2-O

DI4

DI5

DI6

AI 1 NTC 1 AI1-O

AI 2

AI 3 Potentiometer 1 AI3-O

AI 4

AI 5

DO 1 Telefast DO 0 DO0-O

DO 2 Telefast DO 1 DO1-O

DO 3 Telefast DO 2 DO2-O

DO 4

DO 5

DO 6

AO 1

AO 2

AO 3 Meter 1 AO1-O

AO 4

AO 5

M171P Description Label

DI 1 Telefast DI 0 DI1-P

DI 2 Telefast DI 1 DI2-P

DI 3 Telefast DI 2 DI3-P

DI 4 Telefast DI 3 DI4-P

DI 5 Telefast DI 4 DI5-P

DI 6 Telefast DI 5 DI6-P

DI 7 Telefast DI 6 DI7-P

DI 8 Telefast DI 7 DI8-P

AI 1 NTC 2 AI1-P

AI 2

AI 3 Potentiometer 2 AI3-P

AI 4

AI 5

AI 6

DO 1

DO 2

DO 3 Telefast DO3 DO3-P

DO 4 Telefast DO4 DO4-P

DO 5 Telefast DO5 DO5-P

DO 6 Telefast DO6 DO6-P

DO 7 Telefast DO7 DO7-P

AO 1 Meter 2 AO1-P

AO 2

AO 3

AO 4

AO 5

M171E Describtion Label

DI 1 Telefast DI 8 DI1-E

DI 2 Telefast DI 9 DI2-E

DI 3 Telefast DI 10 DI3-E

DI 4 Telefast DI 11 DI4-E

DI 5 Telefast DI 12 DI5-E

DI 6 Telefast DI 13 DI6-E

DI 7 Telefast DI 14 DI7-E

DI 8 Telefast DI 15 DI8-E

AI 1 NTC 3 AI1-E

AI 2

AI 3

AI 4

AI 5

AI 6

DO 1 Telefast DO9 DO1-E

DO 2 Telefast DO10 DO2-E

DO 3 Telefast DO11 DO3-E

DO 4 Telefast DO12 DO4-E

DO 5 Telefast DO13 DO5-E

DO 6 Telefast DO14 DO6-E

DO 7 Telefast DO15 DO7-E

AO 1

AO 2

AO 3

AO 4

AO 5
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Wiring Diagram
M171O
SMD5500/C/S

M171P
EVD7500/C/U
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NTC probe,Type: 103AT/NTCNK103
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Master

Slave 1 Slave 2

D1

D0
Common

5 V

Rp

120 Ω

1 nF

120 Ω

1 nF

Maximum length of bus 1000 m at 19200 bps
Maximum number of stations (without repeater) At most 32 stations (depending on Rp and the number of

4,7 KΩ
Maximum length of tap links 20 m for one tap link

40 m divided by the number of tap links
Bus polarisation Rp should be validated by calculating the equivalent polarisation Re

according to the polarisation of the master and slave stations. Re
must be between 162 Ω and 650 Ω

Line terminator 120 Ω - 0,25Wm in series with 1nF 10V
Common polarity Yes (Common) connected to the PG

Rp

4,7 KΩ
4,7 KΩ

5 V

Suitable polarization Rp
must be calculated

If the master is fitted with a 470 Ω polarisation,
it ’s possible to connect a maximum of
18 slaves with 4,7 KΩ polarisation

Modbus RS485 standard schematic
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Chapter 7
Connection to Smart

Goal:
DMI interface driver installation and connect to the target
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DMI interface setup WIN 7

●As soon as the DM interface is connected, the Windows 7 operating system 
recognizes the newly connected hardware. The steps to be followed are 
described below.

1. Once the hardware is connected, the message shown in the figure will 
appear:

Click on the message to start the 
Guided installation procedure 
Or you can manualy find it at:

Device manager ► other devices ►

Note: Connection procedure:
Connection: first USB then TTL
Disconnection:  first TTL then USB
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Update driver software

2. The screen shown below will appear: select the second option to identify the 
driver

3. In the next screen, select the installation path for the FREE Studio program. 
Unless changed during installation, the path will be as shown in the next  
figure.
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Update driver software

4. Once you have selected the correct path, the screen shown below will 
appear: select Install this driver software anyway
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Update driver software

5. The screen shown below will appear, indicating that the action has been 
performed.

6. On completion of the process, the screen shown below will appear, then close.
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DMI Test via FS Device
To check correct installation of the driver and the port to which the hardware 

has been allocated, check the Windows screens shown below:

Default Address 
range is between 
1 to 5
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Connection to Smart

To download the IEC applications of Studio from the personal computer to the 
Smart target device,

Note: in “Direct”, Smart must not be                    
connected to earth
- it can switch on Smart without external 
power supply
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Smart
Preliminary operations
In order to download the application correctly:
1. connect the DMI hardware interface to the PC.
2. Make sure that the driver is installed

Press Settings
The COM port must previously have been 
read/set in “Peripherals Management” 
(see Reading the DMI interface COM port) 
to be recognized. If there are errors, refer to the 
paragraph “DMI interface connection error”.
* the COM settings must be set on all of the workspaces: Application, Device and User Interface

Connection to Smart

1

2

3
4
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Connect to the target

Protocol Configuration

●For Smart select EWDMI or Modbus*. If the protocol is not activated 
press the Activate button

●The value selected for the COM port will be saved and will reappear each 
time the program is accessed, until it is changed.

●The properties are visible and can be edited from the panel Communication 
> Settings > Properties**

* in the case of Modbus for /S models only with maximum speed  
19200 baud. TTL not for use. NOT POSSIBLE TO UPDate the BIOS.

** obviously, the protocol must be activated beforehand

Factory default configuration:

Address:1, Baud rate: 9600
E,8,1 (CF30=1, CF31=3, CF32=1)
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DMI interface connection error

Error opening serial port

If the “Error opening serial port” message appears, proceed as follows:

1. Check that the COM port setting in the program is the same as one read in 
the COM port reading by the DMI interface.

2. Check if Com Server is opened when you try to connect to Evolution. If not 
disconnect TTL cable, USB port and reconnect first USB and then TTL.

3. Repeat the DMI Detection function.
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Target and Free Studio

Parameters needed for correct connection between the Smart target and Free 
Studio.
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Customize Smart Baud Rate

Smart parameters in the CF folder manages the connection between the target and Studio
If the target is “empty”, i.e. there is no IEC application on the device, Smart will display the 

message FrEE, otherwise fundamental state is displayed (Press F5 to switch to FrEE menu) 

1

2
3 4

5
6
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Customize Smart Baud Rate by FS Device

Only After Connection has been estabilished:

1. Project ►BIOS parameters►All parameters►Configuration
2. CF31 editing►38400 bits/Sec.

2

1

Protocol parameters are loaded at power up, remember 
to switch off controller after changing them.
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Free Studio Device - Main icons

1 2 3 4 5
1. Continuous read/write by toggle auto 

refresh mode. As soon as value changes, 
it will automatically aligne with the target.

2. Select all variables
3. Read all device parameters
4. Write all device parameter
5. Download all (PLC & parameter)
6. It is possible to check the firmware 
version via information. 

6
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Free Studio Device - Colors

1. If the auto referesh is on the 
column value is continiously 
updated and values are written as 
soon as you change them.

Color meanings:
Red: not aligned with the target
Grey: read only data
Blue: value is different from default
Green: data is not visible in the target
Black: aligned with the target 
(if auto referesh is enabled).

1

1
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Connect to the target and Download All

1. Connect
2. Download All
3. Write the default 

parameter values
4. DMI Blink: 

Communicating

1
2

3

2

4
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Editing value
1. Be sure to be Connected
2. Set or change the value (Red, not applied)
3. Write the parameter (Black, applied)1

2

3

2
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Oscilloscope
Drag & Drop
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Oscilloscope

1. Show all values
2. Graph properties
3. Value/div=20 ► OK
4. Vertical split

1 24

3
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Oscilloscope
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Debug on-line/Watch

Select variable to watch

1

2

4
3
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Chapter 8
Target conversion and code import

Goal:
Reuse of existing code and libraries
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Convert project from Smart to Evolution
1. Project ► Select target
2. Free evolution EVD*
3. Change
4. Save the project

1
3

2

4
By target conversion, it is possible 

to reuse the existing projects.
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Converted project from Smart to Evolution

Conversion between Evolution to Smart is 
not fully supported (all resources are 
deleted).
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Import Objects from library (or Project)

Both directions, upgrade & 
downgrade are possible, from:
Smart ► Evolution
Evolution► Smart 

It allows also to import programs, FB, functions from other projects regardless the related target.



117Schneider Electric | Industry Business | OEM Technical Training | April 2014 | Aidin Aliyarzadeh

Import Objects from Project...

1. Select *.ppjs file type
2. Select desired project (Smart )
3. Select desired program & FBD
4. Import Objects

1 4

3

2
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...Assign to Task (in case of program)

1. ? Means that program is not assigned to any task
2. Tasks ► Background ► Add program

1

2
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Assigning imported program to the task

1. Select  the desired program 
name ► OK

2. The ? Disapeares in prgrams 
3. It will assign to to desired 

task (delete non-required 
programmes)

1

1

22

3
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2

Link libraries...

1. Project ► Library Manager
2. Project Library list
3. add/remove
4. Unlink/Relink

1

4

3

2
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...Link Libraries

1

2
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Save a project as:

File ► save a project as :

* Create a folder for the 
project before saving

*
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Chapter 9
Methodology:

Goal:
Navigation between the SW, application, device, connection & familiarizing with 
their abilities
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Free studio/unique programming software

In Unique software suite for Smart and Evolution

Smart Evolut
ion
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Software suite presentation
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Smart Project Architecture

●Application is the programming starting point.

●Device is used to download the overall compiled project and it is the only tool able 
to write EEPROM parameters.

●From Application it will always be possible to open Device directly without having 
to launch the program using the FREE Studio icon.

Download
Code & 
EEPROM

Download
Simulated
EEPROM
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Evolution Project Architecture

●Connection is the entry point for all development activities.
●Device is used to download the overall compiled project and it is the only tool 

able to write EEPROM parameters and the master connectivity configuration
●Application can download only the algorithm and the EEPROM parameters 

and Status Variable definition.
●UI can download only the HMI to EVD
●UI can open SI as well

Download Code, 
HMI & EEPROM

Download
Simulated
EEPROM
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Chapter 10
Fan Management

Goal:
Manage 3 fans base on analogue input configuration
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Physical I/O assignment
Fan Management Function Description:
Fan Management enable by DIL1=True
If AI3P > 3.3 V => Fan1=ON
If  3.3 V < AI3P < 6.6 V => Fan1 & 2 = ON
If AI3P > 6.6 V => Fan1,2 & 3 =ON
If AI3P = - 32768 => Alarm=ON & Fans=False
Monitoring AI3P by the gauge that is 

connected to the AO1P (0-10 V).

1

2

2

2
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BIOS Parameters/AI* Configuration
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New program creation

Click on the magnifying-glass to write the codes.

1

2

3
101
001
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Fan Management, 
Enable/Disable Outputs,
AI monitoring by AO (0-10 V),  
AI disconnection detection codes.
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Debugging/Watch 

3. Drag & Drop the mappings 
into the watch window. 

1

2

3
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Debugging
/Oscilloscope:
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Analogue Input Configuration

1 2
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Analogue Output Configuration

1

2
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Chapter 11
Network

Goal:
Expansion connection to the base unit via CAN BUS 
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Evolution Networking Exercise 
Can Bus

EVE1EVD1
Address 2


Dip Switch 1 = ON

NOTE: Leave the CanOpen end resistor jumpers only to
the endline Devices, in this case EVD1 and EVE1

Goals:

• Connect an expansion EVE1 to Can Bus,
• Configure the AI3 of the EVD as 0-10V input 
• Read AI3 and DI1 of the EVD.
• Write AO1 and DO5, 6 & 7 of the EVD.

Note: Connect GS,H,L of EVD to GS,H,L of EVE 
respectively

DO NOT CONNECT together POWER OUT, 
POWER OUT is just for powering the remote 
EVK1000 display.
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Creating New project‘s connection

2*click

2*click

1

2
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Define the Project Architecture

1. Add new device to 
project project ► Free 
evolution EVD 

1
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FreeEvolution EVD configuration



142Schneider Electric | Industry Business | OEM Technical Training | April 2014 | Aidin Aliyarzadeh

CANopen configuration
● The CanOpen address of EVD is 125, it 

will written in the CONNEC.PAR file, CAN 
On Board parameters are not valid if the 
Evolution is Master on CAN.

●EVE must be set at the speed defined 
here (if changed the devices must be 
restarted, Factory default is 500Kb/s)
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● Drag & drop from device catalogue to the CANopen
● Or
● CANopen►Add►Device catalogue►Select the target

Add an expansion
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Expansion EVE configuration

• Node Number is the address to 
be set on EVE via Dip Switch.
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Dip switch setting ► EVE Address defining

Address=Dip switch +1
2=1+1

Address=Dip switch +1
1=0+1

It is possible to connect up 
to 12 expansion+2 keyboard
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Expansion EVE configuration

●Pressing Add you can eventually define the I/O configuration of EVE that EVD 
will send at powerup

●For example: EVE1 AI3 is set as 0-10V.

3
2

1

4
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Check FS Device for parameter enumeration
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PLC project linking/creation
●Already existing PLC/HMI project can be linked through the related project field.

● If it is empty, a new project will be created and saved in a folder placed where 
the connection project is saved

Dictionay Organization:
When a project is created & saved from CO a directory will be create; then if AP created 
by new from CO;  a directory of the project is created inside the CO directory
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Build the connection
1

Note:
To apply the changes to the network,
free studio asks you to reboot.

2
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Define Application Variables to
be linked to Physical I/O of EVE

●NOTE: If the Status Variables is 
defined in order to be linked to an 
EVE input 

it must be set as not READ ONLY

1. Add
2. Name it
3. Define the type
4. Define the In/Out

1

43
1

2
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EVE Expansion configuration

- Select the Analogue Input 
1 of EVE_1, PDO Tx – Input
- Press Assign
- Link the Physical input to 
the desired Application 
variable
- Repeat this for each EVE 
Input used in your project
- Use PDO Rx – Output for 
EVE Output

Digital Inputs

Dip switches

Analogue Inputs

Fast Digital 
Input
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Assign/UnAssign of physical I/O

2

1
4

3

1. PDO Tx-Intput
2. Choose PLC variable DI
3. Choose PLC variable AI
4. Assign

5

3

6
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Assign/UnAssign of physical I/O

1. PDO Rx-Output
2. Choose PLC variable DO
3. Choose PLC variable AO
4. Assign

4

3

1

2

6

5
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Application Project

You can create your Application project in the usual way using local and field I/O
●sysPeripheralStatus[3] tells the communication status with EVE_1

Note: index to be used with
sysPeripheralStatus[ ], 
index = node number + 2
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Status Variable

●Create Status Variables readable via Modbus
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Setting Menu

●Create folder to be shown on Free Studio Device
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Communication Alarm Checking, Link I/O of EVE
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Green LED management

1. Resources ► Status variables
2. Add  
3. Define: Name, device & application types

1

2

3
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Green LED management

1 4

2

54

3

6



160Schneider Electric | Industry Business | OEM Technical Training | April 2014 | Aidin Aliyarzadeh

Green LED management

1
2

3

4

1.Project ► Programs ► new program
2. Name it as: EVE_Comm
3. Assign it to the timed task
4. Program
5. Communication configuration ► OK
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Green LED management/Output

1

4

3 2
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Build the connection
1

Note:
To apply the changes to the network,
free studio asks you to reboot.

2
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Open with free studio device

1
2
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Download via RS485

1.Project ► FreeEvolution EVD_1 
2. Settings
3. Activate Modbus
4. Properties
5. Communication configuration ► OK
6. Connect to the target
7. Download all

1

4

3
5

2

6
7
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PC TCP/IP configuration
1

4

3

2

5

6

7
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Modbus TCP/download

6

4

3

2
1

7

5

5.change Timeout 
and Connect 
Timeout based 
on the Ethernet 
band available. If 
the connection 
it is not direct it is 
better to increase 
both of them
10000-20000
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Chapter 12
Modbus Communication

Goal:
Connection ATV21/212 to the Evolution via Modbus serial line, write the 
command + speed reference and read the output frequency  
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Machines architecture

Program.
port

EVD*

or BMS 
Modbus
Master

Magelis Family Range

Modbus Slave
USB/RS485

Other Machines

Altivar Drives e.g ATV212/21 

Modbus Master 

3rd Party Modbus 
slave device

• On Board RS485 SL can be either Master or Slave
• Plugin RS485 SL can be either Master or Slave
• They can’t be both master at the same time
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ATV 21/212 via Modbus

Set ups at ATV21:
-LOC / REM = off
-CN0d = 2 Enables Start / Stop control via network
-FN0d = 4 Enables frequency reference to be 
Controlled by network. 
-F800: 1 (default) = 19200bps
-F801: 1 (default) = even parity
-F802: 1 = Address of ATV21 
-F803: 4 = Timeout in seconds
-F829: 1 (default) = Protocol Modbus RTU
-F851: 1 = Communication fault setting 
-(Last commanded operation continues) 
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Master

Slave 1 Slave 2

D1

D0
Common

5 V

650 Ω

650 Ω

120 Ω
1 nF

120 Ω
1 nF

Maximum length of bus 1000 m at 19200 bps
Maximum number of stations (without repeater) 32   (31 slaves)
Maximum length of tap links 20 m for one tap link

40 m divided by the number of tap links
Bus polarisation 650 Ω at 5V and common for the master
Line terminator 120 Ω - 0,25Wm in series with 1nF 10V
Common polarity Yes (Common) connected to the PG

Modbus RS485 standard schematic
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Modbus – ATV21/212

● Drive (slave)
● use Drive Keypad for setting Modbus parameters

Выступающий
Заметки для презентации
Evtl. Beschreibung zu Export Entities… schon hier!?
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Modbus – ATV21/212 navigation
● Drive (slave)

● Drive Menu
1. MODE

2. DOWN KEY 2x

3. ENTER on F---

Extended 
Parameters

Выступающий
Заметки для презентации
Evtl. Beschreibung zu Export Entities… schon hier!?
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Modbus – ATV21/212 configuration
● Drive (slave)

● Drive Menu 1. Press DOWN key repeatedly 
advance to F829

2. press ENTER key to change 
setting

3. with UP/DOWN keys change 
value

4. press ENTER to confirm and exit

5. repeat for parameters listed 
below

1

1
1

1

Important: Cycle 
power on drive 
after changing 
Modbus settings 
for changes to 
become effective.

Выступающий
Заметки для презентации
Evtl. Beschreibung zu Export Entities… schon hier!?
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Modbus – ATV21/212 configuration
Command & Speed Reference
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Modbus – ATV21/212 configuration
Command & Speed Reference

2

1

4

3

Mode ► AUF ► 5*▲ ► fmod ►ENT 
► edit value ► ENT to validate

Mode ► AUF ► 4*▲ ► cmod ►ENT 
► edit value ► ENT to validate1

3
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Modbus link

- Developer must define a set of variables corresponding to what 
he wants to read or write via Modbus using Status Variables.

- In case of 32-bit Modbus registers to be read/write, developer 
should define 2 16-bit Status variable and merge them later.

Registers:
- Command= 64000+1 (W ►FC16)
- Frequency = 64001+1 (W►FC16)
- Output Frequency = 64768+1 (R►FC03)

Message for ATV command:
- Start Command= 50176
- Stop Command= 49152
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Modbus Master Configuration

1. Project ► RS485
2. Modbus configuration
3. Select Generic Modbus

from the catalogue list
4. Drag & Drop it into the 

RS485 

1

3

2
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Generic Modbus

1. After drag & drop
2. Name it & define the Modbus address. 
It is recommended to set the Node number the 

same as the Modbus address
3. Select the desired function code from 

catalogue
* Note: Vectors sysMbRtu* in the folder Modbus

Master are addressed by node number

1

2

3*
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Modbus Function Code

1

2

3

1. Select the required function code
2. Drag & drop it into the Project 
► RS485 ►Generic Modbus 1 
3. Do the general settings 
Registers:
Command= 64000+1 (W  FC16)
Frequency = 64001+1 (W  FC16)
Output Frequency = 64768+1 (R FC03)

Message for ATV command:
Start Command= 50176
Stop Command= 49152

Important: Some slave devices 
requires an offset of one to 
register Address: ATV requires 
it, Evolution doesn‘t need it.
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Modbus Function Code/Settings

1
2

3

1. Start address: address of the first modbus
object to read or write (1..65536).

2. Polling time: minimum waiting period 
between 2 message processing (ms); for 
writing operations, 0 means to write it only on 
variation of the value, for reading operations 0 
means maximum speed.

3. Timeout: the operation will fail when this 
time-out expires (ms). 

4. Wait before send: Waiting time after end of 
previous message response 
(suggested time >=10ms).

Note: Follow below order in Modbus:
1. Write (FC16)
2. Read (FC3) 

4
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Multiple Reg.

1

1. Press Add/Remove in order to define how many 
registers should be written

2. Assign
3. Choose PLC variable ► OK

Note:
- ATV  does not support more than 1 read/ write 

register with the same message
- Waiting time after end of previous message 

response (suggested time >=10ms)

2

3
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Generic Modbus\Register

If a status variable is 
used to write a value 
on variation and to 
read the same value, 
the related write 
message must be 
listed in Connection 
before the 
corresponding read 
message
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…Creating a new Modbus custom device 

Note: To create a new 
Modbus custom device, 
choose Tools / Run 
ModbusCustomEditor; the 
external 
ModbusCustomEditor tool 
will be launched, with a 
new empty document. 
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Creating a new Modbus custom device… 

Note:
Advantage:  Easier to be used in Connection
Disadvantage: Message are not optimized & 
common polling time for all messages

1

2

3

4
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ATV control, Local variable definition

Note: Two 
independant group 
of blocks must be 
place in two 
separate networks



187Schneider Electric | Industry Business | OEM Technical Training | April 2014 | Aidin Aliyarzadeh

Modbus Communication Alarm

See next chapter for download details
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Recompile & Build
1

Note:
To apply the changes to the network,
free studio asks you to reboot.
Yes: if you want to validate it.
Cancel: if you want to dismiss

2
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Open with free studio device
See next chapter for further 
details on download via TCP
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Chapter 13
Modbus TCP

Goal:
Modbus TCP configuration, project download and socket management
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PC TCP/IP configuration

1

4

3

2

5

6

7

2
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Modbus TCP/download

6

4

3

2
1

7

5

5.change Timeout 
and Connect 
Timeout based 
on the Ethernet 
band available. If 
the connection 
it is not direct it is 
better to increase 
both of them
10000-20000
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Modbus TCP socket

1.Plugins
2. Catalogue ► drag & drop Ethernet into the plugins part
3. Set the Network: Ethernet1 
Maximum 9 additinal sockets(+2 opened by default). 
Note that 5 sockets are related toWebserver

Note (Additional Modbus TCP sockets): 
If you have to increase the number of Modbus/TCP
sockets (by default they are 3) or if you have to implement 
binding between Evolution.

1

2

3
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Modbus TCP/debugging

5

4 3
2

1
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Chapter 14
Modbus Slave

Goal:
Configuration of Free Studio to creat connection between Vijeodesigner & 
Evolution 
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Modbus Slave

●Status variables and EEPROM parameters have a modbus address and they 
are all Holding Registers, regardless the type of variable defined into Device 
Type

●EEPROM parameters are always R/W
●Status Variables are RO by default

●Set to False Read Only in case of R/W Status Variable
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Modbus Slave

● In Free Studio Connection, set the Mode of RS485 of the controller to Not 
used
 It means that the RS485 on board is configured as a slave port
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Modbus Slave
● In Free Studio Device, in Bios parameters, click on RS485 On Board
●Configure the Modbus communication:
 Address of the controller
Baudrate
Stop bits
Parity

●Change to communication settings
require a controller restart
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How to connect Freeway to VijeoDesigner target

●Create a new driver
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Vijeo Designer

●Configure the driver as configured in Free Studio

●A new Modbus equipment has been created



201Schneider Electric | Industry Business | OEM Technical Training | April 2014 | Aidin Aliyarzadeh

Vijeo Designer

●Configure the Modbus equipment (right click):
●Enter the address as set in Free Studio
●Select IEC61131 Syntax
●Adressing mode: 1-based (Unity Quantum)
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●Create your variables:

●Define the Data Source: External
●Defin the Scan Group: name of your Modbus equipment you have created
●Specify the register address of the variable

Vijeo Designer
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Chapter 15
Web server

Goal:
Embedded & customized web pages
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Web visualization

1. Connect to the target ► FreeEvolution EVD_1 
2. Open internet browser (Google Chorome)
3. Type 10.0.0.100 in the address bar
4. In the windows security pop-up:
Default Username: administrator 
Default Password: password
► OK

1

4

32

1
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Embedded web pages



206Schneider Electric | Industry Business | OEM Technical Training | April 2014 | Aidin Aliyarzadeh

Embedded web pages
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Application web pages

1. Resources► Web site ► Add table page 
2. Name it (Exercise Visualization)
3. Add  a new record
4. Select the desired parameter from list
5. Title the page & Select the site template
6. Define the control type & Label it

4

3

2

1

6

5
ATV Control
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Web visualization/customized page

1. Developer ► Build Web site 
2. Connect ►Device ► FreeEvolution Configuration

Web site download
Web site preview

Note: Embedded Web Pages are no longer available
if Application Web Pages are used

1

3

2
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Custom web page preview

Use below address to return back to the embedded page: http://10.0.0.100/evoindex.htm

Custom page address: http://10.0.0.100/index.htm

If the device type is Boolean or Enums other 
types of control type are selectable.

Web folder is located in PLC 
► Web to edit the header
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sysHTTP_ListableFilesExt library

Note: FILES.CGX and FILES.CGI 
can be provided as example pages
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Chapter 16
Firmware update

Goal:
Updating Smart & Evolution firmwares by Free Studio Device
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Firmware update 

In Free Studio Device

Click on “Connects to Target”
Once the device is connected, 
 Check the firmware version 

If the firmware version is not the
last one, click on BIOS download

Note: Smart, the controller must be powered only by DMI.

Note.
Smart: Application Lost
Evolution: Application kept
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Firmware update 

●Click on Browse

●The default folder opened contains the
last firmware version released with
the software. 

Select the last firmware version
Click on Open



214Schneider Electric | Industry Business | OEM Technical Training | April 2014 | Aidin Aliyarzadeh

Firmware update 

●Select Direct Mode

●Click on Download 

●The same procedure 
can be applied to 
Evolution except for 
Mode selection (not 
available) and power 
supply to be 
provided.
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Chapter 17
User Interface

Goal:
Local & Remote display programming by User Interface
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DemoField Example

CanOpen

EVE1EVD1
Address 2


Dip Switch 1 = ON

NOTE: Leave the CanOpen end resistor jumpers only to the endline Devices, in this case EVD and EVE1
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Keyboard EVK configuration

1
2

3 4

5

6
7
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Keyboard EVK configuration

Network settings should 
be aligned to the real 
address of the EVK 
(127 is the factory 
default).
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• 124 or 123 are the 
addresses to be used in 
the HMI management 
menu of EVK

• 124 is the factory 
default

CANopen configuration

1 keyboard to communicate with base ►
set the channel=124
Second keyboard to communicate with 
base ► set the channel=123 
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HMI project linking/creation

HMI:Local Display
HMI Remote: EVK1000

2. Name it ► OK ► User 
Interface project starts 
automatically

3 & 4. Local display will have 
the same HMI of the 
remote one.

1

5

4

2

3

Local HMI might not work on remote display
Local & Remote displays (Identical) ► HMI remote
Local & remote displays as future option► HMI remote



221Schneider Electric | Industry Business | OEM Technical Training | April 2014 | Aidin Aliyarzadeh

Preliminary: Actions

Define the global action 
related to the buttons
1. Activate action bar icon
2. Global actions
3. New action
3. Define the Key
4. Define the Action

1

54

2
3
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Preliminary: Link parameter file

- Link the parameters file of your application project.
- Select short name to prevent long variable names

1

2
3

4
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Target Vars & parameters

• Name can be eventually 
changed manually in order 
to adapt the same UI to 
different project without 
changing the set already 
defined (@ syntax)

• The list of 
parameters/status variables 
will appear

• Note: Remember to refresh 
parameters file every time 
you change the related 
Application project
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Toolbar description

1. Insert static
2. Insert new edit
3. Insert new image
4. Insert new animation
5. Insert new button
6. Insert new check box
7. Insert new progress
8. Bring to front
9. Sent to back

1 62 3 4 75

8 9

We will see how to manage all these objects…
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Page creation & page properties

1

1

2
3

3

4

Note.
Press Enter to apply 
the changes otherwise 
it will be lost.
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Page Customization
●Main Page Properties

●Customize grid
● Insert Title Bar
●Define Font size
●Define Title
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Page Navigation by Graphic Button

1. Define a new page
2. Create a button in the source page

3. Text/img can be changed base on selection status
4. Define the Action and Action Par properties of the button

1

2

3

4
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Main/My First Page…

2 3 4

5

8

76

9

1

1
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Text Objects

1. Insert static text

Define the required font size 
(2 sizes are available)

3

2

2

3

1

4

4

4



231Schneider Electric | Industry Business | OEM Technical Training | April 2014 | Aidin Aliyarzadeh

Text Objects...
●Text to be translated:

1. Define the string ID and the string in the current language
2. Use the ID instead of static string

1 2
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...Text Objects
●Text to be translated:

1. Languages are defined in the language selection tab
2. String table can be exported/imported and translated

1

2

3
1

44. Max = 19 Chars
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String Table

Let‘s define our String table…

1

2
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Edit Objects - Values
1. Select object  or Drag and drop desired variable from from PLC tab

●Main Properties
●Variable: syntax used is: @PLC.<application var name>
●Format
●Selectable: True for R/W, False for RO
●Refresh
●High/Low Limit: shows ----- outside the range

●Select the @PLC.<var> desired
●Default Properties comes from Ap definition
●Selectable: False means, not editable.

11
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Edit Objects - Values

Note:
- EEPROM & status variable use syntax 

@PLC.<application var name> 
- Global, local, target  var & PLC vars use 

standard syntax : Just the var name
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Enumerative creation

1. Resources► Enumeratives
2. Add new
3. Name/Rename it ► Open
4. Enumeratives tree

1
2

3
4
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Enumeratives

1 2
3

Note: 
Target format HH:MM convert a 
number into Hours:Minute format

3
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Enumeratives

Enumeratives are translatable
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Page Navigation – Close Action

Note: 
- An already opened page can’t be opened: i.e. from this page it is not possible to open Main.
- Main can be reached only through a Close Action (close current and open previous page)

M

A

B

C
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Image Object

1.Import bitmap
2. Browse ► select form image library
3. Select the desired image ► Open
4. Import 

1

2
4

3
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Image Object

1. Inset new image
2. Properties ► Bitmap ► select the 

desired image from imported list1

2
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Local and Global Variables

1
2

3

4

3

1. Double click on Page► Local variables (or on Global variables)
2. Add new
3. Define name & type
4. Added to the list
5. Added to the Local variable tree

5
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Animation-Image lists 

1. Resources► Image lists
2. Add new
3. Name/Rename it
4. Image lists tree

1

2

4

3
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Animation

4

1

1. Insert new animation 
2. Rename it if needed (optional)
3. Select  from Image list
4. Select from property definition

5

52

2

3

4

5

5. Filter  variables as page locals
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UI simulation

There are two parallel, identical ways to simulate, via UI or Ap 

1

2

3

4
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Sets creation

1

1. Double clicks
2. Add
3. Type

3.1 Variant: Variable/parameter sets even of not equal type 
3.2  Strings: text

4. Dynamic: compresses the list when invisible variable/parameter are used

32

4 Goal: creating a list of 
variables & strings with 
scroll up/down ability
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Strings Set filling 

1

1. Double clicks
2. Select the string form the list
3. Define the visible field
Dynamic visibility: 
If the visible field is False, then 
empty parameter‘s rows will be 
removed from the list and the list 
could be shrink pack.

2

2

3
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Variant Set filling 

1

2

21. Sets
2. Format: One 
decimal point
3. Selectable False 
in case of RO 
elements 

3

3
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Dynamic Set filling 

Note: the item is displayed only 
if Visible field is TRUE

1
2

3

4
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Set Objects…

Note: The number of elements  of the sets shown in the same page 
should be equal

Syntax:
String:
#Setparname(0), #Setparname(1), …, #Setparname(element x page -1)
Variant:
#Setparvalue(0), #Setparvalue(0), …, #Setparvalue(element x page -1)

1

2
3

4

4

3
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Set Objects…

Syntax Variant:
#Setparvalue(0), #Setparvalue(0), …, 

#Setparvalue(element x page -1)

6
5

6
5- Size the text dimension based on the 

longest string to be displayed
- Size the Edit dimension base on the 

biggest digits to be displayed
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Set/Objects/Page x out of Y

Note: 
Data type will be define automatically as soon 
as variable recognized, if not there is a mistake 
in the variable name.
1. $ PagIndex=Current Page Number
2. $PagNumber= Total pages number

1
2

1
2
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Dynamic Set Objects

1 2
3
4

3 4

2
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Maximum number of charachters

Number of Chars:
If you do not resize the related window will be 0, and you might face with refresh problem. 
It is possible to set it maximum 21 charachters (>21 Chars=> out of display)
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Set Objects/up & down arrows

2

2

1

1
Bitmap 1. BmparrowDown:

2. BmparrowUp:
3. Bmpauto:
4. BmpCool 16*16:
5. BmpGlobe 24*24:
6. Bmpheat 16*16:

6

4

5

3
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Script
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Global Variables To Be Defined

2 2

1

1
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Video_GetParam() Video_SetParam()

• Video_GetParam() read and value from the
parameter file Id, with address
SETPOINTMODBUS.  Result is copied into
tmpINT.

• Video_SetParam() write tmpINT

1

1

2

3

3
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• Video_GetParam() read and value from the
parameter file Id, with address
SETPOINTMODBUS.  Result is copied into
tmpINT.

• Video_SetParam() write tmpINT

Video_GetParam() Video_SetParam()

1

2

2
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Script: Video_SendEvent()

• When counter is greater than 1000 the
script emulates a Long Left button press 
using function Video_SendEvent().

• Long Left action causes a page Close



261Schneider Electric | Industry Business | OEM Technical Training | April 2014 | Aidin Aliyarzadeh

Pages Events

Main

B

A 1
2

3

1. OnLoad
2. OnDeactivated
3. OnUnload
4. OnActivate4

1
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Pages Events

Event: CLoc counts the number of times
Script page is displayed

1
1

12

2
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Global On Timer Script

Note:
Global On Timer always runs in background

1
2 3
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Global On Timer Script – Page Timeout

1

1

Force a page close if no button
has been pressed for 20sec 
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Global On Timer Script – Page Timeout

1

Script can not be empty

2

Main Page can‘t be closed: 
Global actions is bypassed by
local ones



266Schneider Electric | Industry Business | OEM Technical Training | April 2014 | Aidin Aliyarzadeh

Progress Bar

2

1

3
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• Message can be opened from every page but it can‘t have child page
• Message is identified by its Msg ID
• Message can be opened using Video_SendEvent( kWM_MSG, MsgID )
• Msg ID 101-102 are automatically opened with low/up range error

Messages...
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... Message
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Testing Messages
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Target Vars
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Target Vars: sysKeyPressed

1

2
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Target Vars

1. sysCurrentSelectedPosition
changed value based on the current
selected object
2. sysTimer works as in Ap
3. Key_Code (see previous slide)
4. sysBackLight
5. sysMSK is the firmware mask
6. sysVER is the firmware version

1
2

3
4
5 6

3

4
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Remember to align Ap UI and Co projects

● “Recompile all”the Application Project

●Compile the User Interface project

●Build the Connection project in order to align it to the linked Ap and UI project
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Open Free Studio Device

1.Tools►Open with free 
Studio  Device

2. Define settings
3. Connect to the EVD
4. Download all

1

43

2



275Schneider Electric | Industry Business | OEM Technical Training | April 2014 | Aidin Aliyarzadeh

Upload HMI from EVD to EVK...

In the BIOS Menu of EVK (Long press of down + left if a HMI is already 
loaded). 

In order to run HMI:
1. Select HMI Manage
2. upload 
3. Press OK to confirm 
4. Press to run HMI
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Upload HMI from EVD to EVK...
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Chapter 18
Evolution USB

Goal:
- DownLoad/UpLoad via USB
- Retain variable configuration
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USB device (PC ◄►target)

USB Formated FAT32
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What is inside Evolution Filesystem or USB ?

Inside both Evolution/USB Pen Drive:
PLCIEC.COD : Application binary file
HMIIEC.COD : User Interface binary file (not mandatory)
HMIREM.KBD : Remote User Interface binary file (not mandatory)
CONNEC.PAR : Master Connectivity settings (not mandatory)

Inside Evolution:
Webserver files
Logging file
Others…

Inside USB Pen Drive:
PARAM.DAT (.RAW) : Parameter Map file
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Parameter map file

PARAM.DAT file includes a set of Evolution BIOS& IEC parameter values. 

PARAM.DAT can be renamed as PARAM.raw in order to skip parameters’ 
range limit check (used in case of par limited by other pars).

PARAM.DAT file can be created via IEC code using the target var
(see next slides)

PARAM.DAT (.RAW) can be manually created/modified in order to contain 
even a subset of the full map.
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Use USB host from IEC code

- Upload an application from the pen drive to Evolution
- Upload/Download a parameter map from evolution to the pen 

drive.

sysUSBCommand is the system command
to upload/download to/from USB-Host:

7 = load PARAM.BIN from USBH
8 = load PLCIEC.COD from USBH
9 = load HMIIEC.COD from USBH
10 = load PARAM.DAT from USBH
11 = save PARAM.DAT to USBH
12 = load CONNEC.PAR from USBH
13 = load HMIREM.KBD from USBH
14 = save sysUsbFileName file to USBH, file name can be name. ext or *.ext
15 = load sysUsbFileName file from USBH, file name can be name.ext or *.ext
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Automatic Upload via USB pen drive

Uploading automatically an application via USB pen drive
• Copy into a pen drive the COD/PAR/DAT files
• Edit an UPLOAD.TXT file containing the list of the files to be uploaded

Note. PARAM.DAT (.RAW) file can be uploaded only if FREE Evolution has 
been rebooted with related application, therefore PARAM.DAT (.RAW) cannot 
be uploaded at the same time of PLCIEC.COD

The upload file can have a prefix from 00 to 15, for example 03UPLOAD.TXT:
• Copy into a pen drive the UPLOAD.TXT (03UPLOAD.TXT) files as well
Files with numeric prefix are uploaded only if the Evolution dip-switches 
match the prefix; in this way it is possible to store on the same USB pen 
drive one or more Evolution applications.
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USB-LED status during upload

The upload process starts when the pen drive is plugged and can be monitored 
through the led status which, during the upload process, are controlled directly by 
Evolution bios.

The process results which will switch on the red led are the ones related to a value of
sysUsbStatus>1.

After the process, Evolution must be restarted in order to run the new application. 
File PARAM.DAT is uploaded by an Evolution only if the Bios Mask and Par_POLI7 of 
the Evolution that has generated the PARAM.DAT are the same as the destination 
Evolution. 

The parameters’ map update does not require to switch off Evolution.
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Firmware Update By USB

How To Update:
• Copy the relevant .bin file into a USB pen drive (e.g. msk423_18.bin)
• Connect USB pen drive to Evolution
• Firmware will be downloaded into Evolution
• Yellow LED will blink during download. 
• Remove USB pen drive as soon as Yellow LED will switch off
• Evolution will automatically reset and will reboot

BIOS are available @<C:\Programs>\Eliwell\free Studio\Catalog\FreeEvolution\<firmware>
<firmware> = msk423 for EVD, msk477 for EVC.

Please Note: a SYSTEM FAULT message will appear - DO NOT CONSIDER -
BIOS upgrade has been completed successfully

Note: Evolution make a filter based on the filename in order to prevent user mistakes 



286Schneider Electric | Industry Business | OEM Technical Training | April 2014 | Aidin Aliyarzadeh

Using the USB Device - Adding library

IMPORTANT NOTE:
1. USB Device is disabled by default
2. Do not forget: safe to remove the target
3. Do not access Evolution  through USB 

device meanwhile any application is
accessing Evolution filesystem

1
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Enable/Disable PC host access to file System Function

1

2

3

4

Sys_USBD_Command (USINT 
Command)
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PC host connection status function

1

2

3

4

Sys_USBD_status (USINT dummy)
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USB application download workflow
Cfg_Node name.par @ project root

Rename it as CONNEC:PAR

Project name(PLC).bin @project root ► PLC ► Download

Rename it as PLCIEC.COD

Create Text file as shown

Copy them to the USB stick

Project name(HMI).bin @project root ► HMI ► Download

Rename it as HMIIEC.COD

Power cycle to apply them into the RAM

Note.
Always use Capital letter in renaming TXT files 

Project name(HMI).bin @project root ► HMI ► Download

Rename it as HMIREM.KBD
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USB data upload workflow...

1.Connect to the target via Ap
2. Drag & drop sysUsbCommand into the watch window
3. Write value=11

2

3
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3

2

1
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...USB data upload workflow

To monitir the USB-Host status:
Drag & drop sysUsbStatus into the watch window

2
1

3
1

1

2
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Evolution - Retain Variables
A RETAIN variable 
indicates that the 
variables within the 
structuring elements are 
retentive, i.e. they keep 
their value even after the 
target device has been 
reset or switched off.

Evolution  supports 
up to 100 DWORD 
‘retain variables’ 
ensuring their data 
will not be lost after a 
shutdown.

Retain variable values 
can be changed several 
times without affecting 
internal memory 
performance.

Note: RETAIN variables 
cannot be displayed in 
the Watch window

1
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Evolution - Retain Variables

2

3

1

4 5

6

1
• Set as variable address size DW (double 
WORD) and data block 102.0.xx where xx=0,...99
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Chapter 19
Documentation

Goal:
Creating document and exporting by Application, Device & User Interface as 
report or as useing them by other products such as Vijeodesigner
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Application - Export to Excel...

1

2

3

4
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... Export to Excel

Name Type In/Out Description
AI1_E INT in
DI1_E BOOL in
DI2_E BOOL in
DO1_E BOOL out
DO2_E BOOL out

1
2

3
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User Interface - Documentation

2

3

1
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User Interface - Documentation
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Device - Export to Text file...
Select a Table
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Device - Export to Text file...

1 2

3
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Q & A
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Thanks
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Break

15’
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Launch
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